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Seccion 1 - Introduccion.

CVS es el acronimo de Concurrent Versions System. Es un sistema de control de versiones cuyo desarrollo
comenzo en 1986, y en el que han participado muchas personas. Es un software de dominio publico.
Actualmente quien mantiene CVS es Cyclic Software, en Washington DC, y hay montones de informacion
en su sitio web: www.cyclic.com.

El principal “problema” de CVS es que usa una interface a base de comandos en linea. Ya que la mayoria
de los desarrolladores prefieren utilizar una bonita interfaz grafica de usuario, varios grupos a lo largo y
ancho del mundo han desarrollado interfaces graficas de usuario para el nucleo de CVS. De entre estas
interfaces graficas la mejor y disponible para Windows NT/98 es WinCvs, desarrollada y mantenida por un
grupo de gente a lo largo del mundo. Se puede encontrar informacion sobre WinCvs en su sitio web en
WWW.Wincvs.org.

Notese que las versiones de cvs y WinCvs documentadas aqui difieren un poco de las versiones standard.
La diferencia mas visible se puede apreciar en los ejemplos del comando import. Un parche no oficial
llamado Main Branch Import ha sido aplicado para permitir la importacion de ficheros directamente al
trunk !!! en lugar de una bifurcacion de vendedor. El parche puede encontrarse en
http://www.cyclic.com/cvs/dev-trunk-import.txt.

Este documento describe la instalacion de WinCvs y explica algunos de los conocimientos basicos
necesarios para empezar a usar CVS. Por favor, dirige todas las preguntas o problemas sobre este manual a
Don Harper (usa los grupos de noticias para cuestiones sobre cvs o el mismo WinCvs.
[mailto:donharper@earthlink.net].

Notese también que este documento asume que la maquina es Windows NT, sin embargo, para los usuarios
de Windows 98 deberia ser tambien 1til aunque haya unos pocos detalles diferentes.

Seccion 2 - Instrucciones de Instalacion

La version actual de WinCvs es la 1.1, que esta todavia en fase de pruebas beta y esta disposible en el sitio
web de WinCvs en www.wincvs.orqg. Para usar la interface de lineas de comandos embebida en el
producto debe obtener Tcl/Tk 8.1.1 en www.scriptics.com.

Para empezar la instalacion de WinCvs, desempaquete en un directorio temporal el fichero zip descargado.
Ejecute el programa de instalacion (Setup.exe). Instale el software en el directorio Archivos de
Programa\GNU\WinCvs 1.1 en un disco local (preferentemente C:).

Para instalar Tck/Tk, ejecute el fichero tcl811.exe descargado de scriptics.com. Instale en el directorio por
defecto que sugiera el programa de instalacion.

Si quiere un editor realmente bueno, instale EmEditor (eme200e¢i.exe). Es un producto shareware, por lo
que tendra que abonar los $25 que cuesta si despues quiere seguir usandolo. Hay mas informacion sobre
EmEditor y su sistema de licencia en la web
http://www.nifty.ne.jp/forum/femsoft/index-e.htm. Tambien puede usar cualquier
otro editor que prefiera.

Si quiere una utilidad de comparacion de ficheros gratuita instale ExamDiff (examdf16.zip). Si quiere mas
caracteristicas instale la version shareware ExamDiff Pro (edpro21c.zip), en lugar de ExamDiff. ExamDiff
Pro cuesta $25 la licencia. Mas informacion sobre ExamDiff y ExamDiff Pro esta disponible en el sitio
web http://www.nisnevich.com.



http://www.cyclic.com/
http://www.cyclic.com/
http://www.cyclic.com/cvs/dev-trunk-import.txt
mailto:[mailto:don.harper@lamrc.com]
http://www.wincvs.org/
http://www.scriptics.com/
http://www.nifty.ne.jp/forum/femsoft/index-e.htm
http://www.nisnevich.com/

WinCys se anadira una entrada en el Menu Inicio, pero si lo desea puede crear ademas un acceso directo a
Archivos de Programa/GNU/WinCvs 1.1/wincvs.exe en el escritorio.




Seccion 3 — Guia para principiantes de WinCvs

3.1 Estableciendo la Carpeta Raiz del Area de Trabajo (Work Area).

Antes de ejecutar WinCvs cree una carpeta que sera la raiz de su area de trabajo en local. Por supuesto
puede manejar multiples areas de trabajo con WinCvs, pero se le hara mas facil el seguir estas instrucciones
si crea primero su raiz del area de trabajo.

Cuando ejecute WinCyvs, lo primero que vera es la pantalla principal del browser. En este ejemplo se ve un
area de trabajo seleccionada como actual, por lo cual, lo que muestra el browser difiere de lo que usted vera
cuando ejecute WinCvs por vez primera.

“' - [E:\MautilusTest\EtchPM\srci]
File Edit %“iew CvsAdmin CusFiles CvsFolders

Selections Window  Help

B (=] a2 @l (s]| 5l @

L

&l =] =

& Blale] (5] =) &l

wolor] o] 21a] ]

MName: | Rev | Option I Status | Tag I Dte: I Conflict =
b3 11 File Thu May 13 19:53:37 1999
b4 1.1 File Thu May 13 19:58:37 1999
b4 1.1 File Thu May 1319:55:37 1999
R 1.1 File Thu May 13 19:58:37 1999
-3 1.2 File \ied May 19 19:37:43 1599
b3 1.1 File Thu May 13 19:58:37 1999
-3 1.1 File Thu May 1319:59:38 1999
® 1.1 File Thu May 13 19:59:38 1999
R 1121 File Eranch1 Wad May 26 20:15:45 1599
h:4 1.1 File Thu May 13 19:55:38 1999
® File Thu May 131 19949
L ¢
BEERlios b, ® i Rl Thu My 13 15:59-35 1969
® 1.1 File Thu May 13 19:53:39 1999
-4 11 File Thu May 1319:55:39 1999 i
-4 1. File Thu May 13 19:59:39 1999
R 1.1 File Thu May 13 19:53:35 1999
R 1.1 File Thu May 13 19:55:39 1999
b4 1.1 File Thu May 1319:55:39 1999
h:8 1.1 File Thu May 13 19:58:39 1999
-3 1.1 File ThuMay 13 19:59:39 1999
R 1.1 File Thu May 13 19:55:39 1999
R 11 File Thu May 1319:55:40 1999
k-4 1.1 File Thu May 13 19:55:40 1939
b3 11 File Thu May 13 19:53:40 1959
RIE 1.1 File Thu May 13 19:55:40 1999 _';]
< {
CVSROOT: :pserver:don@nautilus:/usr/local/cvs-test (password authentication)
TCL is available, shell is enabled : help (select and press enter)

ForHelp, press Fi ‘ | |

A

Lo primero que deberia hacer es cambiar la carpeta raiz del browser a la carpeta que usara como raiz de su
area de trabajo. La raiz del browser se puede cambiar tanto desde el ment Cvs Folders->Macros folder-
>Change Root como desde el icono de los “binoculares” en la barra de herramientas:

@il'tt o7

En ambos casos se abrira un panel donde puede seleccionar la carpeta a abrir con el browser. Localice la
carpeta que desee usar como raiz de su area de trabajo y haga doble-click en ella para ver el icono de
carpeta abierta. Si solamente selecciona la carpeta con un solo click, seleccionara la carpeta padre en lugar
de la deseada. Esto es una caracteristica no deseada (bug) de todos los comandos de WinCvs que usan esta
forma de seleccionar carpetas.

| &




En el siguiente ejemplo, la raiz del area de trabajo se establecera a E:\Work. Noétese que la carpeta “Work”
esta seleccionada y que muestra el icono de carpeta abierta.

Select a folder to open with the browser I

Selecta folderto open with the browser

Folders:
ahork

] Cws-Admin
1 EtchPd
1 Home
[
Drives:
g: Daon ;I letwark, . |

3.2 Estableciendo las preferencias (Preferences) en WinCvs

Abra el panel de preferencias de WinCvs seleccionando Cvs Admin->Preferences en el menu principal.
Como se ve, hay cinco paneles de preferencias en WinCvs. El panel General es el mas importante y el que
se usa con mas frecuencia.

WinCvs Preferences

General IGIDbaPs-I Parts i'Pery iWinCVSI

—Enterthe CVSEOOT

—Authentication |
"passwd' file on the cws server Ll
Lise version ; |Use cws 1,10 _'r_l

Ok I Cancel | Ay Help




3.2.1 Panel de preferencias General

Hay tres campos en el panel de preferencias General :

WinCwvs Preferences

General IGIDba}s-I Farts i'F‘ery iWinD\ISI

— Enter the CVSEOOT

—Authentication |
"passwd file onthe cvs server :l
Lise versiof | IUse ovs 1,10 ll

(0] I Cancel | Ay Help

Establezca el CVSROOT a cualquier cosa similar al ejemplo de mas arriba:
:pserver:don@jupiter:/envyl/cvs

En este ejemplo, don es el nombre de usuario en el dominio local que sera usado para acceder al repositorio
[envyl/cvs en el servidor jupiter. NOTA: debe haber una entrada en
C:\WINNT\system32\drivers\etc\Hosts definiendo la direccion IP del servidor (jupiter en este caso):
nnn.nnn.nnn.nnn _jupiter

Establezca el campo Authentication a “passwd” file on the cvs server. Establezca el campo Use version a
Use cvs 1.10.

3.2.2 Panel de preferencias Globals

Establezca las opciones del panel de preferencias Globals como se muestra a continuacion, a no ser que
este seguro de lo que est4 haciendo.



WinCwvs Preferences

3.2.3 Panel de preferencias Ports

Hay cinco campos en el panel de preferencias Ports:

| 'YWinCvs P

Normalmente se usan los valores por defecto de estos campos.
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3.2.4 Panel de preferencias Proxy

Hay dos campos en el panel de preferencias Proxy :

| ¥inCvs Preferences

Este panel es necesario para utilizar cvs a traves de un servidor proxy.
3.2.5 Panel de preferencias WinCvs

Hay tres cosas que establecer en el panel de preferencias WinCvs :

Establezca el program used to open files a su editor favorito. WinCvs ejecutara este programa cuando haga
doble-click en cualquir fichero mostrado en el browser que no tenga un tipo de fichero asociado en
Windows.
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Si quiere usar un programa para ver las diferencias entre ficheros graficamente, marque la casilla y use el
boton para localizar su programa favorito que realice esta tarea. Notese que por alguna razon, WinCvs solo
ejecuta el programa seleccionado cuando se ejecuta diff desde el modo “graph” (grafico). El modo “graph”
se explicara en una seccion posterior.

Establezca HOME folder apuntando a una carpeta donde CVS guardaré las informaciones del username y
password encriptado. Esta puede ser la misma carpeta con la instalacion de CVS (Archivos de
Programa\GNU\WinCvs 1.1) o su carpeta “home” si tiene una en su entorno Windows NT. Si especifica
este directorio separadamente del area de trabajo podra afiadir, modificar o borrar areas de trabajo
solamente con uncomando de login.

3.3 Haciendo log in en el servidor

Antes de que cvs pueda ejecutar ninguna operacion sobre ficheros, el usuario debe hacer log in en cvs.
Haga log in en cvs seleccionando Cvs Admin->Login... en el menu principal. Se le solicitara una
password (la password asociada a su usuario en el dominio local, como se especifico en CVSROOT -
Seccion 3.2.1):

Password authentication

~Enterthe password

[~

Zancel |

Introduzca su password y haga click en el boton OK. Si pudo hacer log in sin problemas vera un texto
similar al siguiente en la ventana de status:

cvs -q login
(Logging in to don@nautilus)

wxE%EECVS exited normally with code Q¥¥¥**

Si no pudo hacer log in y por tanto no pudo entrar en el servidor vera un texto similar al siguiente en la
ventana de status:

cvs -q login ]

(Logging in to don@nautilus) ] ] ]

cvs [login aborted]: authorization failed: server nautilus rejected access

wxE%kECVS exited normally with code 1¥¥¥¥*

Si intenta usar otros comandos de CVS antes de hacer log in en el servidor, los comandos fallaran y vera un
similar a este en la ventana status:

cvs import: could not open E:\Don/.cvspass: No such file or directory
cvs [import aborted]: use "cvs Togin" to Tog in first

12



3.4 Haciendo Check Out de un mdédulo

CVS organiza los repositorios en forma de médulos. Un modulo es una jerarquia de carpetas y ficheros
empezando en cualquier carpeta en la jerarquia del repositorio. Todo repositorio tiene un modulo llamado
CVSROOT que almacena los ficheros administrativos. Es una buena practica dejar que estos ficheros los
mantenga un administrador. Solo el administrador deberia poder afiadir nuevos médulos al repositorio.

Para hacer checkout de un modulo del repositorio al PC local hay que conocer el nombre del modulo. Sino
conoce el nombre del modulo seleccione Cvs Admin->Macros admin->List the modules on the server en el
ment principal. Este comando le mostrara la lista de modulos en la ventana de status de WinCyvs:

ek

**CVS exited normally with code Q¥¥#*%%*

Core Core
EtchPM EtchpPMm

La primera entrada de cada linea es el nombre del médulo y la segunda el nombre del directorio raiz del
modulo respecto a la raiz del repositorio.

Una vez que se conoce el nombre del modulo, se puede hacer checkout del mismo para colocarlo en el area
local de trabajo seleccionando Cvs Admin->Checkout module... en el menu principal. Se visualizara un
panel para permitirle seleccionar la carpeta destino (area de trabajo local). Vaya a la carpeta deseada y
haga doble-click en ella para que se seleccione y se muestre el icono de carpeta abierta. Si accidentalmente
selecciona la carpeta pero no hace doble click, se hara el checkout del modulo en la carpeta padre. En el
ejemplo siguiente se hard checkout del modulo en la carpeta Nautilus Test.

Select a directory to checkout to :
Selecta directory to checkoutto :

ednautilustast

Zancel |

YautilusTest
1 Core
£ CVSROOT
3 EtchPid
1 TestEmpty

Dirives:

g: Daon ;I Hetwark. . |

Una vez que haya seleccionado la carpeta destino y haga click en el boton OK, se visualizara el panel
Checkout settings. Puede introducir el nombre del médulo en el campo correspondiente (EtchPM en la
figura siguiente). Si es necesario, la carpeta destino tambien puede ser modificada desde este panel.
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Pulsando en OK en este momento hara checkout de la ultima version del modulo para la vifurcacion
principal (cvs se refiere a esta como el trunk).

Checkout settings

Checkout settings I Chackout options | Glubalsi

—Enterthe module narme and path onthe seryer:

[EtchPi |

i~ Local place to checkoutto:
‘ Chenge folder | E:\NautilugTast

" Checkoutfiles ta the console window (avoids stickiness]

[T Donotrecurse

Ok |: | Cancel Ay Help

Si se desea una version vifurcada (branched) o etiquetada (tagged) de un modulo, se puede especificar el
nombre de la bifurcacion (branch) o la etiqueta (tag) en el panel Checkout options :

Checkout settings

Checkout settings  Checkout options | Globals i

— Checkout (sticky) options:
I Bydate: | =

L |

I By revisionftagbranch ; |Allian|:e_\f1.4

[ It no matching revision is found, use the most recent one

OKH Cancel Ay Help

En el ejemplo anterior se hara checkout de la ultima version de todos los ficheros del moédulo EtchPM de la
bifurcacion (branch) Alliance V1.4en lugar de hacerse checkout de la ultima version de la bifurcacion
principal (trunk). Notese que también es posible seleccionar la la version para que se quiere hacer el
checkout especificando una fecha.

Una vez que ha establecido el nombre del modulo y las demas opciones, se hara checkout del médulo
cuando se pulse el boton OK. El progreso y el resultado del checkout se pueden ver en la ventana de status:
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cvs -q checkout EtchPM (in directory E:\NautilusTest)
EtchPM/MakefiTle

EtchPM/EtchPM/Makefile

EtchPM/EtchPM/data/Makefile
EtchPM/EtchPM/data/A2/EtchPM.script
EtchPM/EtchPM/data/A2/Makefile
EtchPM/EtchPM/data/A2/Alarms/EtchPM.almdef

cccccc

EtchPM/src/tasks.c
EtchPM/src/tempctrl.c
EtchPM/src/wat_cntrl.c

ccc-

wHk%ECVYS exited normally with code Q%=

Desafortunadamente, no porque haya hecho checout de un modulo aparecera este en el panel izquierdo del
browser, en la vista de carpetas. Utilice la tecla F5 o el botdn derecho del raton (Reload View) para
actualizar el display, o pulse en el icono Refresh View de la barra de herramientas:

@ P

En el ejemplo siguiente se ha hecho checkout de 4 modulos en el area de trabajo Nautilus Test, y la carpeta
Core esta seleccionada en la vista de carpetas en el panel izquierdo. Las subcarpetas de Core son visibles
en la vista de ficheros en el panel de la derecha.

¢ - [E:\NautilusTestiCorel]
File Edit Wiew CuvsAdmin CvsFiles CuwsFolders Selections Window Help

= e e T S R M
mf=| &

| @lsE] =5 = 5

=3 NautilysTest Name | Bew. I Optisc. |:Staius | Tag | Ciate |'i2f'ur-1ﬂict I

C [ Auxiliary_Clack Folder

; dhoot_strap Folder
&1 EtchPM dcatabase Falder
#21 TestEmpty [Documents Falder
[ddrivers Folder

b Falder

[ Ihost_config Folder

bt Folder

[ZrecipeClient Folder

dsys_config Folder

[ Itest_drivars Folder

[dutilitiss Folder

_dvme_trag Folder

[Iwatchdog Faolder

CVSROOT: :pserver:don@pautilus:/usr/local/cvs-test (password authentication)
TCL is available, shell is enabled : help (select and press enter)

ForHelp, press F1 | 2
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3.5 Actualizando (update) un area de trabajo

Una vez que se ha creado un area de trabajo, los ficheros pueden pasar a estar desactualizados conforme
otros desarrolladores hacen checkin de sus modificaciones desde sus propias areas de trabajo. El comando
update de CVS permite que un area de trabajo sea actualizada a los Gltimos cambios que se hayan
realizados en los fuentes (los ultimos checkin,s realizados). Otro uso frecuente del comando update es
cambiar entre bifurcaciones (branches) y versiones etiquetadas (tagged version).

El comando update (aligual que otros muchos comandos de WinCvs) se puede invocar sobre una carpeta,
un fichero o una seleccion (el conjunto de carpetas o ficheros que estén seleccionados en ese momento).
Por tanto, al comando update se puede acceder desde los mentis Cvs Files, Cvs Folders, y Selections.
Posiblemente la forma mas comoda de actualizar (update) un fichero o carpeta es seleccionarlo con el
boton derecho del ratdn, lo cual hace que ademas se visualice el menu Selections, y todo ello con un solo
click de raton. Si quiere usar para esto la barra de herramientas, en ella tambien hay iconos para estas dos
operaciones:

Actualizar carpeta (Update Folder):

|| == (w2 =l
and Actualizar seleccion (Update Selection):

] @] o]

Independientemente de como se como se invoque el comando update, se visualizara el panel Update
settings:

Update settings

Update settings l‘StickythtiDnai Merge-opﬁonsi Glabalsl

I Checkoutfilesta standard output (svoids stickiness)

[ Do notrecurse into sub-olders
" Resetany sticky date/tag/~k' optiohs

[ Create missing directoties that existinthe reposton:

(0] [ . I Cancel Ay Help

La opcion Do not recurse into sub-folders puede ser 1til para hacer update solamente sobre la carpeta
seleccionada y no sobre todas sus subcarpetas (la recursion es siempre la opcion por defecto de cvs).

La opcion Reset any sticky date/tag/-k options se usa para hacer update hacia atras a la Gltima version de
los ficheros en la bifurcacion principal. Durante el desarrollo se puede hacer update a una bifurcacion
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(branch), a una etiqueta (tag) o por fecha, y esto ultimo significa obtener un area de trabajo actualizada a la
bifurcacion principal. Esto es lo que hace esta opcion.

La opcion Create missing directories that exist in the repository es 1til para obtener los nuevos directorios
que han sido afiadidos al repositorio desde que se hizo checkout del modulo la vez anterior.

Para hacer update a una bifurcacioén que no es la principal, hacer update a una version etiquetada (tagged
version) o hacer update por fecha hay que usar el panel Sticky options . En el siguiente ejemplo un area de
trabajo que ya existe seria actualizada a la ultima version de todos los ficheros de la bifurcacion

Alliance V1.4 :

Update settings

Updata seflings  Sticky options | terge aptions i Glohals I

— Sticky (persistents) options :
[ Before date: | [Z|

L |

-

I Betrieve rew ftag/branch ;

[ It no matching revision is found, use the most recent one

(0] Cancel Ay Help |

En el panel Merge options hay algunas opciones mas sofisticadas relacionadas con las mezclas (merge).
Consulte el manual de cvs para mas informacion sobre este panel:

Update settings

Updata sefings | Sticky options  Merge options | Globals |

—tderge options::

€ Onlythis res ftag | =]

0 Plus with this res fag | | ‘:_l

QK I Cancel il Help

=)
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3.6 Editando un fichero

Por defecto, cuando se hace un checkout de un modulo o un update del area de trabajo los ficheros
obtenidos son no modificables. Para modificar un fichero hay que usar primero el comando edit de manera
que el fichero se marque como modificable. En WinCvs un icono a la izquierda del nombre del fichero en
la ventana del browser vista de ficheros indica el estado modificable/no modificable del fichero.

Los ficheros de solo lectura se indican con el icono:

Rl

Los ficheros modificables se indican con:

¢

Para invocar el comando edit y hacer un fichero modificable seleccione el fichero y pulse el icono Edit
selection de la barra de herramientas:

El comando edit tambien se puede ejecutar desde el menu emergente que se visualiza pulsando el boton
derecho del reton, opcidn Monitors selection->Edit selection o desde la opcion Selections->Monitors
selection->Edit selection, pero usar la barra de herramientas es mas comodo.

Después de que el fichero ha sido marcado como modificable, este puede ser modificado haciendo solo
boble-click sobre el.

Para volver a marcar el fichero como no modificable (es decir, de solo lectura), usese el comando unedit
desde los ments o la barra de herramientas.

Después de modificar un fichero su icono en la ventana de vista de ficheros del browser se pondra en rojo y
la columna status cambiard a Mod. File como se muestra en el siguiente ejemplo donde fue modificado el
fichero applmain.c:

H. - [E:\NautilusTestyEtchPM\srci]

[ [= E3

File Edit wiew CvsAdmin CwsFiles CwsFolders Selections Window Help
=T T o W S a5 s N S T R e P
= &
= MautilusTest Blame | Rev. | Ot |.5tatus | Tag | Date |;Cf0nflict | &
2.2 Care RIE 171 File Thu May 13 19.59:37 .
A1 CVSROOT " 11 File Thu Mey 1319:59:37
EtchPh ® 11 File Thu bay 13196837
- mdAB kS 1.1 File 37
- @ data 4 1.2 Mod. File /1 %
® [ doc b 141 File ThuMay 13 19.59:37 .
-0 EtchPM R 1.1 File Thu May 13 13:53:38 .
)T ® 11 File Thu May 13 1359:38
- ] Ph_sim -3 1121 File Branchi Wed May 26 20:15:45 .
i 1 s ® 11 File Thu May 13 19.55:38 .
(] WinCws Y e File Thu May 13 19:59:38 .
| (21 TectErmpty fid 1.1 File Thu bay 13 1969:38
= P » 11 File Thu bMay 13 19.53:38 .
B 131 File Thubday 13 19:59:39 .
=] inNehinne 5 | Fil= Thit hdans 13 18:R9-39 :_j
cvs -q edit applmain.c (in directory E:\NautilusTest)EtchPM\src)) =l
rxrxECVS exited normally with code Q*****

ForHelp, press F1

N
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3.7 Visualizar las diferencias antes de hacer commit (modo texto)

A menudo es util tener la precaucion de ejecutar diff antes de hacer commit de un fichero al repositorio.
Esta seccion describe los pasos necesarios para comparar un fichero a la version que hay en el area de
trabajo con la version actual del mismo que hay en el repositorio. Las diferencias pueden verse tanto en el
modo texto estandar del comando diff en la ventana status como en modo grafico (para esto ltimo es
necesario que haya establecido cual es el programa externo con el que vera las diferencias, como se explico
en la Seccion 3.2.5). Esta seccidn se refiere al formato texto en que se visualizan las diferencias. Vea la
siguiente seccion (Seccion 3.8) para un ejemplo del comando diff en modo grafico.

El comando diff se puede ejecutar de cualquiera de estas tres formas:

1) Seleccione el fichero usando el botdn izquierdo del raton y utilice el menu Selections->Diff
selection

2) Seleccione el fichero usando el boton derecho del raton y use la opcion Diff selection

3) Seleccione el fichero usando el botén izquierdo del raton y use la barra de herramientas:

=l Blam] 2] =) &l

| ElEx] e

Una vez que se invoca el comando diff, se visualizara el panel Diff settings :

Diff settings

Dift saﬂings_ |Glc|ba|si

- Selectwhat youwantto compare against

& Campare your revizion with the same remote revizion:

" Compare your revision with another revision/tag/branchidate |
—RBevision or date :

=l (s a dais | f_l ‘

. Compare two revisions/tags/branches/dates |

—RBevision or date :

=l (s a dais | f_l ‘

I~ Dionotrecurse into sub-directores

=)

0] I C”ancel iy Help

El panel Diff settings tiene varias opciones, pero solo la primera opcion tiene sentido en este ejemplo
(porque lo que queremos hacer es comparar nuestra version contra la del repositorio). Asegurese de que
selecciona la primera opcion como se muestra arriba y haga click en el boton OK.
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La version en formato texto de las diferencias entre ficheros (si las hay) se visualizara ahora en la ventana
de status como se muestra aqui:

cvs -q diff applmain.c (in directory E:\NautilusTest\EtchPM\src)
Index: applmain.c

RCS file: /usr/local/cvs-test/EtchPM/src/appimain.c,v
retrieving revision 1.1

diff -rl.1 applImain.c

988,993c988,994

< int Metal9600PTX_installed = FALSE;
< int single_plane_transfer = FALSE;
< int chill_232_present = FALSE;

< int pump_232_present = FALSE;

< int Tonwork_present = FALSE;

< int scrubber_232_present = FALSE;

> int Metal9600PTX_installed = TRUE;
> int single_plane_transfer = TRUE;

> int chil1_232_present = TRUE;

> int pump_232_present = TRUE;

> int lonwork_present = TRUE;

> int scrubber_232_present = TRUE;

> int advanced_endpoint_installed = TRUE;

JORORORONON
LR R

CVS exited normally with code 1#*%%*=%

El texto de la ventana de status de WinCvs puede ser seleccionado, salvado a un fichero, o impreso
simplemente activando la ventana status (haciendo click en cualquier parte de ella) y usando los menus Edit
y File. También se puede borrar el texto de esta ventana con Edit->Select All y Edit->Cut (cortarlo).

3.8 Visualizando las diferencias antes de hacer commit (modo grafico)

Como se menciond en la Seccion 3.7, a menudo es util tener la precaucion de ejecutar diff antes de hacer
commit de un fichero al repositorio. Esta seccion describe los pasos necesarios para comparar la version de
un fichero en el area de trabajo contra la version actual del mismo en el repositorio. Las diferencias pueden
verse tanto en el modo texto estandar del comando diff en la ventana status, como en modo grafico (para
esto Gltimo es necesario que haya establecido cual es el programa externo con el que vera las diferencias,
como se explico en la Seccion 3.2.5). Esta seccion se refiere al modo grafico en que se visualizan las
diferencias. Vea la anterior seccion (Seccion 3.7) para un ejemplo del comando diff en modo texto.

En WinCvs el programa grafico que muestra las diferencias solo se puede usar desde el modo graph. El
modo graph de WinCvs muestra todas las versiones de un fichero en formato grafico. El grafico puede ser
generado de cualquiera de estas tres formas:

1) Seleccione el fichero usando el botdn izquierdo del ratéon y el menu Selections->Graph
selection

2) Seleccione el fichero usando el boton derecho del raton y despues Graph selection

3) Seleccione el fichero usando el boton izquierdo del raton después la barra de herramientas:

Una vez que se ha invocado el modo graph, se visualiza el panel Log settings :
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Log settings
Log setings ILDgfiItersi Globals |
™ Logonthe default branch

[ Do notrecurse into sub-olders

™ Prirt ofily the RCS files narmes

v ‘Do not printtag names:

[T Do notprintuset logs

(0] I Cancel Ay Help

Hay muchas opciones en los paneles Log settings que el usuario puede explorar cuando le sea necesario
utilizarlas. En este ejemplo se ha seleccionado la opcion Do not print tag names, ya que puede ser una
opcion usada con mucha frecuencia para evitar el que haya demasiada informacion en el grafico que se
visualice despues. Los nombres de etiquetas en cvs (tag names) se refieren a los nombres de bifurcaciones
(que son ttiles de ver), pero tambien se refieren a las versiones etiquetadas (tagged versions) que
probablemente no les interesan a los desarrolladores.

Una vez que haya seleccionado las opciones deseadas haga click en el boton OK para visualizar el grafico.

El grafico de este ejemplo muestra que para applmain.c hay actualmente dos versiones en el repositorio:

i - [Untitled] H=] E3

B@ File Graph Help Winclow TR

@] sz e &5 5l e BlEx EEE R EelE] 2] =] w5 5] 25 2z =

Revision : 1.2

Locked by : 'don’

Date : 1999/5/19 19:37:43

Author : 'don'

State : 'Exp'

Lines : +12 -8

Description :

Add new options for advanced endpoint.

For Help, press Fl I i 7

Para visualizar las diferencias entre la version del fichero en el area de trabajo y la version del fichero en el
repositorio (1.2), haga click primero en la version mas reciente del fichero en el repositorio, como se

21



muestra arriba. Notese que en la mitad inferior de la ventana se visualiza informacién acerca de la version
seleccionada.. La informacion que se muestra es el autor, la fecha-hora de modificacion, y el mensaje de
log para la version seleccionada del fichero.

Ahora puede visualizar las diferencias en modo grafico, tanto desde el menti Graph usando Graph->Diff
como desde la barra de herramientas del modo graph:

El programa externo con el que visualizar las diferencias (vea como establecerlo en la seccion 3.2.5) se
ejecutara como se muestra en el siguiente ejemplo:

Notese que el programa externo usado en el ejemplo anterior para ver las diferencias (ExamDiff Pro) tiene
muchas opciones, incluida la posibilidad de configurar los colores, ignorar los espacios enblanco, etc,...
(menu View->Options...). También hay una opcién para salvar las diferencias en formato UNIX (menti
File->Save Unix Diff File... ).

Tenga cuidado al cerrar la ventana del modo graph despues de ver las diferencias, o podria acabar cerrando
completamente el programa WinCvs. Una forma mejor de usar WinCvs puede ser usar el modo Tile, que
se puede seleccionar con Window->Tile.

# ExamDiff-Pro \

Eiles  “iew HMavigation Search
SARDBEFLESR | RD

Info

FHRBE+Z% 483548 e

Diff 1. Change lin
|[EATEMPY1T |ENautilus TestiEtchPii srchapplmainc
975 lunsigned char #*gosr_addr = (unsigned char *)0zfffe.s|[ 375 [unsigned char =gesr addr = (unsigned char *)0xfffe201b: 4|
976 |short model s 976 |short madel
977 |int eop = 0; 977 lint eop = 0;
978 lint Consale, Bemote, Host, Pressure Con- 978 |int Consale, Remote, Host, Pressure Controller
4749 Gap Controller, Temp Controller; 975 Gap_Controller, Temp Controller:
980 |int TURBO_BASE: 980 |int TURBO_BASE ;
981 |char pm_logical name[10]; 981 |char pm_logical name[10];
982 ichar tm_logical nams[10]; 982 [char tm_logical name[10];
983 |char event logical name[10]; 983 [char event logical name[10];
984 ichar waferflow_logical name[10]: 984 [char waferflow_logical name[10];
985 |char recipe logical name[10]; 985 |char recipe logical name[107]:
986 char gem_logical_name[107]; 986 [char gqem_logical name[107]:
987 |char anfPI ame [30]:

98‘7_’

char anfPID_filename[
int e BEHOETE

307
al

156 |in
ag

: . !
int = g4 1nt —!
int 191 |lint

£ 10t ;
193 £ 19 i1t seituk t = TRUE;
894 lint advanced_endpoint_installed = TRUE;

994 985

995 extern int rfEniI0PointsInitComplete; 996 |extern int rfEniI0PointsInitComplete;

996 lextern int confRingl0PointslnitComplete; 997 extern int confRingl0OPointslnitComplete;

997 extern int tempIOPointsInitComplets; 998 |extern int templOPointsInitComplete;

998 lextern int heESCIOPointsinitComplete; 999 extern int heESCI0PointsinitComplete;

i 1000
1000 lextern int nofat_rf rs232; 1001 |extern int nofat_rf rs232;
1001 lextern int nofat rf configured; 1002 |extern int nafat_rf configured;
1002 lextern int debug_micro; 1EIU'_5' extern int debug_micro:
1003 |extern int filament off to HY timer: 1004 |extern int filament off to HYV timer;
1004 lextern param_t crnt_param[]: 1005 [extern param_t crot_param[]:
1005 |extern short wat_autozera idz, vat valve regquest. 1006 |zxtern short vat_autozero idx, vat valve request idz, v
1006 gascal_gas_idx, PM_State_idz, Trans 1007 gascal_gas_idx, PM_State_idzx, Transport_St
1007 turbo state idx, No. Vac idzx: ~||1008 turbo state idx. Mo Vac idx; -
008 |4 + 1009 |4 _»[_i

1 difference found | [added [Deleted ] [Chanaed [Chansed inchonaed
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3.9 Hacier commit con un fichero o una carpeta

Despues de que se hayan editado uno o mas ficheros, sepuede hacer commit al repositorio con ficheros
individuales o con un arbol entero de carpetas usando el comando commit. Se puede invocar el comando
commit de varias formas:

1) Seleccione un fichero o carpeta con el boton izquierdo del raton y seleccione la opcion de
menu Selections->Commit selection

2) Seleccione un fichero o carpeta con el boton derecho del raton y despues use la opcion
Commit selection

3) Seleccione un fichero o carpeta con el boton izquierdo del ratéon y despues use la barra de
herramientas:

| EilE S e

Una vez que se ha invocado el comando commit, se visualizara el panel Commit settings :

Commit settings

Commit settings I Globals I

—Enterthe log message :

Add new options for advanced endpaint,

Pravious logs or CVS| Template: ;‘

[ Do notrecurse

oK Cancel Ay | Help

Teclee un mensaje de log y pulse el botén OK para hacer commit de los cambios. Si ha seleccionado para
hacer commit una carpeta y no desea que también se haga commit con sus subcarpetas, marque la opcion
Do not recurse. Los resultados de la operacion de commit se visualizaran en la ventana status como a
continuacion:

cvs -q commit -m "Add new options for advanced endpoint." applmain.c (in
directory E:\NautilusTest\EtchPM\src)
Checking in applmain.c;

/usr/local/cvs-test/EtchPM/src/appimain.c,v <-- applmain.c
new revision: 1.2; previous revision: 1.1
done

k% ECVYS exited normally with code Q%=
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3.10 Anadir ficheros o carpetas al repositorio

Se puede afiadir ficheros o carpetas al repositorio tanto con el comando add como con el comando import.
Los programadores deberian normalmente usar el comando add para afiadir ficheros o unas pocas carpetas.
Hay solamente dos situaciones donde se deberia usar el comando import:

- Si los ficheros a crear requieren la creacion de un nuevo médulo (por ejemplo debido a
que no existe previamente un mddulo para los mismos). En este caso se debe usar el
comando import. Para mantener una determinada convencion en la forma de nombrar los
modulos, es una buena idea dejar la tarea de creacion de modulos al administrador de cvs.
El nimero de moédulos en un repositorio tambien hay que controlarlo para evitar
confusiones.cierta homogeneidad en los nombres de los médulos.

- Si se desea afadir una jerarquia de varios niveles a un modulo que ya existe, puede ser
tedioso anadir cada nivel manualmente. WinCvs permite afiadir todos los ficheros y
subcarpetas de una sola carpeta en una sola operacion. Realizando esta operacion
manualmente, habria que repetirla para cada una de las subcarpetas hasta el final de la
jerarquia. Ademas los ficheros binarios habria que afiadirlos en una operacion aparte,
haciendose la tarea considerablemente tediosa. En esta situaciones en mucho mas facil
usar el comando import para importar la jerarquia completa a una subcarpeta de un
modulo existente. Tambien es una buena idea utilizar al administrador de cvs o pedirle
ayuda cuando haya que importar ficheros de esta forma.

Si el comando add le parece el mas apropiado (el caso frecuente), lea la Seccion 3.10.1 para mas
informacion sobre el uso del comando add . Si necesita usar el comando import lea la seccion 3.10.2 o
contacte con su administrador de cvs.

3.10.1 Adadir ficheros o carpetas (a un modulo que ya existe) usando add

Antes de que se pueda afiadir ficheros o carpetas a un médulo, debe existir un area de trabajo en la cual se
haya hecho checkout del mddulo en cuestion. Entonces se pueden crear ficheros y carpetas dentro del area
de trabajo mediante cualquiera de estos procedimientos:

- crear una carpeta vacia desde el Windows NT Explorer

- copiar los ficheros desde otro lugar.

- copiar una jerarquia existente desde otro lugar (considere el uso de import, Seccion 3.10.2)

- crear los ficheros usando un editor de textos, Microsoft Word o cualquier otra aplicacion.

Hay tres puntos importantes que hay que mencionar relacionados con el comando add:

1) El comando add NUNCA es recursivo en cvs. Esto significa que afiadir una jerarquia a un
modulo ya existente es un proceso manual. Hay que afiadir manualmente los ficheros y las
carpetas para cada nivel de la jerarquia. Si necesita afiadir una jerarquia de mas de un nivel al
repositorio, considere usar el comando import (Seccion 3.10.2).

2) Cvs necesita que se le diga que ficheros tratar como binarios y que ficheros tratar como
ficheros de texto. Si intenta afiadir un fichero binario como fichero de texto, WinCvs lo
detectara y se lo advertira, pero es mas seguro afiadir ficheros de texto con las versiones Add
de los comandos de WinCvs y los ficheros binarios con las versiones AddBinary

3) El comando add solo afiade el fichero al area de trabajo local. Despues hay que usar el
comando commit (Seccion 3.9) para anadir permanentemente los ficheros al repositorio.
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Una vez que todos los ficheros y carpetas han sido colocados en el area de trabajo, estamos preparados para
afiadirlos al repositorio. Como sucede con otros comandos, WinCvs proporciona varias formas de invocar
el comando add:

1) Seleccione los ficheros o carpetas usando el boton izquierdo del ratén y después la opcion de
menu adecuada:

Selections->Add selection para ficheros de texto o carpetas
Selections->Add selection binary para ficheros binarios

2) Seleccione los ficheros o carpetas usando el boton izquierdo del raton y use el boton derecho
del raton para abrir el menu Selections . Escoja la opcion de ment adecuada:

Add selection para ficheros de texto o carpetas
Add selection binary para ficheros binarios

3) Seleccione los ficheros o carpetas usando el boton izquierdo del ratén y use el icono adecuado
de la barra de herramientas:

Add selected (para carpetas o ficheros de texto):

Notese que el fichero o carpeta seleccionado deberia verse con un icono “?” y estatus Unknown como se
muestra a continuacion:

|

Marme | Few. | ... | Status | Tag
R [E PARALLEL Driver.c 1.1 File

A Sirmulation Folder
R [El siozSerialc 1.1 File
¥ 2 sio?Serialh 11 File

[} sio2SetialHwh 11 File
% E] SmriBrd._Driver.c 1.1 File
R [E] SmntBrd_Driverh 1.1 File

] SOFT_Diriver.c 1.1 File

R 2] STEFFER_Diiver.c 1.1 File
WE STRING Driverc 1 File
iy EI Test Driverc Liniknoan
WV [E «240lb.c

4]

Una vez que el comando add (o add binary) se ha invocado, el fichero o carpeta sera anadido al area de
trabajo. El estado de la operacion add se puede ver en la ventana de status de WinCvs, como se muestra a
continuacion:

cvs -q add Test_Driver.c (in directory E:\NautilusTest\Core\drivers\)
root server: use 'root commit' to add this file permanently

**CVS exited normally with code Q##*#***
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Como se ha indicado, el fichero o carpeta todavia requiere que se haga una operacion de commit para
afadir realmente el fichero al repositorio.

Despues de que un fichero es afiadido al area de trabajo, su status cambia a “Mod File”, y la columna

revision (Rev.) deberia mostrarse como 0, como se muestra a continuacion:

Mlarne - | e, | Q.. | Status | Tag =
[E] PARALLEL Driver.c 1.1 File

A Simulation Folder
R [El sin2Serialc 1.1 File
W =] sio?Senalh 11 File
R E] sio2SenalHw.h 1.1 File
=] SmrBrd. Oiriver.c 1.1 File
] SmntBrd_Driver.h 1.1 File
W =] SOFT _Driver.c 1.1 File
R 2] STEFFER_Diiver.c 1.1 File
W E] 5STRING Driver.c 1.1 File
il ! k [ kod. File
=] x240lib.c 11 File -
4] | s

El fichero(s) afiadido puede puede ahora ser editado o hacer commit con €l contra el repositorio (Seccion
3.9).
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3.10.2 AAadir ficheros o carpetas usando import

Este comando import de cvs permite anadir una jerarquia existente de ficheros y carpetas al repositorio
creando un nuevo moédulo o afiadiendolos a un modulo ya existente. Como se vio en la Seccion 3.10, hay
varias razones para que este comando deba ser usado principalmente por un administrador de cvs.

Al contrario que el comando add , la jerarquia que va a ser importada NO debe estar en el area de trabajo
local ants de ejecutarse el comando import. Posteriormente, una vez que el comando import se haya
completado, se puede hacer checkout de la jerarquia completa al area de trabajo local.

Hay dos ejemplos en esta seccion. En el primero (Seccion 3.10.2.1), una jerarquia ya existente de ficheros
de texto y binarios sera importada a un modulo ya existente en el repositorio. En el segundo ejemplo

(Seccion 3.10.2.2) una jerarquia ya existente de ficheros de texto y binarios serd importada como un nuevo
modulo.

3.10.2.1 Importar una jerarquia de ficheros a un médulo ya existente

Al contrario que otros comandos, WinCvs solo proporciona una forma de invocar el comando import :

Seleccione Cvs Admin->Import module... en el ment principal. Se visualizara el panel Select:

select a directony to import :

Selecta directory to import ;

etdata-ab
Zancel |

Dirives:

g: Daon ;I Hetwark. . |

Localice la carpeta que quiere importar y haga boble-click en ella para ver el icono de la misma como una
carpeta abierta. Si selecciona la carpeta con un solo click de raton, se seleccionara la carpeta padre y todas
sus subcarpetas en lugar de la deseada. Esto es un bug de todos los comandos de WinCvs que usan esta
forma de seleccion de carpetas. En el ejemplo de arriba la carpeta Data-A6 esta seleccionada y su icono se
muestra como una carpeta abierta.
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Después de hacer doble-click sobre la carpeta a importar, pulse OK. En ese momento WinCvs examinara
la jerarquia para determinar cuantos ficheros se van a importar y determinar el tipo de cada uno de ellos
(texto o binario). A este proceso se le llama filtrado (filtering), y puede tomar algin tiempo si la jerarquia
de ficheros es grande. Dirante este tiempo la ventana de status de WinCvs visualizara una linea por cada
carpeta examinada, como se muestra a continuacion:

Filtering 'E:\Data-A6'...

Filtering 'E:\Data-A6\A2'...
Filtering 'E:\Data-A6\A2\Alarms'...
Filtering 'E:\Data-A6\A2\db'...
Filtering 'E:\Data-A6\A2\pg'...
Filtering 'E:\Data-A6\A2\Rack'...
Filtering 'E:\Data-A6\A2\Recipe'...
Filtering 'E:\Data-A6\A4'...
Filtering 'E:\Data-A6\A4\Alarms'...
Filtering 'E:\Data-A6\A4\db'...
Filtering 'E:\Data-A6\A4\dcp'...
Filtering 'E:\Data-A6\A4\pg'...
Filtering 'E:\Data-A6\A4\Rack'...
Filtering 'E:\Data-A6\A4\Recipe'...

Cuando el proceso de filtrado se haya completado, se visualizara el panel Import filter con los resultados
del proceso de filtrado. Este panel lista las extensiones de ficheros encontradas en la jerarquia a importar y
el tipo que cvs le asignara al afiadir el fichero (TEXT o BINARY). En el siguiente ejemplo no hay errores
ni warnings. Sin embargo, en algunos casos WinCvs puede encontrar un fichero con una extension que
normalmente se asigna a los ficheros de texto aunque el fichero en cuestion aparezca como binario. Los
errores pueden ser ignorados (de cualquir forma, WinCvs hara normalmente lo correcto) o se puede usar el
boton Edit para cambiar los valores que WinCvs haya establecido.

Después de que haya revisado el panel Import filter pulse en Continue para empezar el proceso del import:

Import filter

Fixthe errors:(it any) before continuing the impott process ;

Eniry state | Entny description | Entry kind |

™ Ok Twpe *txt TE=XT

MoK Type *doc BINARY

A OK Type *dcp TEXT

MoK Type * st TEXT

MOk Type *rif TEXT

oK Type* repdef TEXT
A Ok, Type *rack TEXT
MoK Type *rack_template TERT
MOk Type™pos TEXT
MoK Type Makefile TEXT
M OK Twpe *.script TE=XT
MoK Type* dh TEXT
M 0K, Type *almdef TEXT
MoK Type*recover TEXT

Edit | Carcel Carntinte 'a

Despues de pulsar el boton Continue se visualizara el panel Import settings:
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Import settings
Import settings llmpmﬁ-nptions | Glubalsl

—Selectthe module name and path onthe remaote sepver:
tch ]

~Initial wandor and release tags :

Verdortag [l

Release tag: I'mFJUfT

—Enterthe log message

Importfitst phase of AF data files,

i

el Help

ok, [: I Cancel

En este ejemplo, se esta creando una nueva carpeta A6 bajo el modulo EtchPM ya existente. Notese que la
carpeta Data-A6 importada no aparecera en el repositorio. Todos los ficheros y subcarpetas de Data-A6
seran importados al repositorio bajo la carpeta A6 . Este ejemplo pretende mostrar que una carpeta puede
ser importada con un nombre diferente. Hay que introducir cuatro campos antes de iniciar el import :

- Teclee el nombre de mdédulo y path como se muestra arriba. Notese que cvs REQUIERE que
se usen caracteres “/” (forward slash) para separar nombres de directorios. Si se usase un
caracter “\” (backslash) se crearia un nuevo mddulo en la raiz del repositorio llamado
EtchPM\AG, en lugar de un nuevo directorio A6 bajo el dierctorio EtchPM ya existente.

- Introduzca cualquier cosa en los campos Vendor tag y Release tag . Estas etiquetas raramente
se usan y pueden ser borradas después.. Por tanto, puede introducir cosas como VTAG y
RTAG, y borrarlas despues de que el import se haya completado. Desafortunadamente, CVS
las necesita para ejecutar el comando import. Se pueden borrar despues de que se haya hecho
el import seleccionando la carpeta de mas arriba en la jerarquia y usando Delete tag, al que se
puede acceder desde el menu Selections->Tag selection .

- Introduzca un mensaje de log adecuado (este mensaje sera parte de la informacion de log
asociada a los ficheros para la version inicial 1.1), que aparecera en el fichero si la palabra
clave $Log figura en el (solo ficheros de texto).

Despues de haber introducido valores en todos los campos pulse el boton OK para iniciar el import .
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Durante el import se ejecuta el comando de cvs del mismo nombre y la salida del mismo se visualiza en la
ventana de status de WinCvs, como se muestra en el siguiente ejemplo:

cvs -q import -I ! -I ¢vS -W "*.doc -k 'b'"™ -m "Import first phase of A6
data files." EtchPM/A6 Avendor Import (in directory E:\Data-A6)
EtchPM/A6/Endpoint.doc

EtchPM/A6/EtchPM. doc

EtchPM/A6/Makefile

EtchPM/A6/README. txt

EtchPM/A6/A2/EtchPM.script

EtchPM/A6/A2/Alarms/EtchPM.almdef

Z2Z2ZZ2ZZ2Z2

EtchPM/A6/A4/Rack/SILYLATION. rack
EtchPM/A6/A4/Recipe/EtchPM. rcpdef
EtchPM/A6/A4/Recipe/SilyPM.rcpdef

zZ2ZZ-

No conflicts created by this import

wHk%ECYS exited normally with code Q%=

Ahora que los ficheros han sido importados al repositorio se puede hacer checkout de los mismos al area de
trabajo ejecutando el comando update sobre la carpeta padre. En este ejemplo, se ha seleccionado el
directorio EtchPM y despues update con el boton derecho del raton. Se visualiza el panel Update settings:

Update settings

Update settings I.Stic:kyuptianei Merge-apﬁansi G'Inbalsl

I Checkout filesta standard output {(aveids stickiness)
[T Do notrecurse into sub-folders

I Resat any sticky dateftag/ k' aptians

¥ Create missing directoras that existin the repositon

[-\OK I Cancel Ay Help
iy

Active la opcion Create missing directories that exist in the repository y pulse el botén OK para obtener en
el area de trabajo una working copy (copia de trabajo) de los ficheros importados.

Si desea que los ficheros que acaba de importar sean accesiblen en el repositorio como un modulo
separado, vea la Seccion 4.1. Puede ser util permitir a los usuarios hacer checkoput de una parte del arbol
de un modulo en lugar de obligar a que el checkout se haga siempre del arbol completo.
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3.10.2.2 Importar una jerarquia de ficheros a un nuevo médulo

Al contrario que con otros comandos, WinCvs tiene una tinica forma de invocar el comando import :

Seleccione Cvs Admin->Import module... en el meni WinCvs. Se visualizara el panel Select ...:

Select a directory to import : EE3

Selecta directory to import ;

Folders:

eAnew-core

.
Zancel |

z re
£ Auxiliary Clock
1 boot_strap

C1 database

1 drivers

Ch

1 host_config

T hwtest

1 recipeClient
£ sys_config

£ test drivers

T utilities

1 wme_trap =

Dirives:

g: Daon ;I Hetwark. . |

Localice la carpeta que quiere importar y haga doble-click en ella para ver el icono de carpeta abierta. Si
selecciona la carpeta con un solo click de raton, se seleccionara la carpeta padre y todas sus subcarpetas, en
lugar de la carpeta deseada. Esto es un bug de todos los comandos de WinCvs que usan esta forma de
seleccionar carpetas. En el ejemplo de arriba se ha seleccionado la carpeta New-Core, que muestra su
icono de carpeta abierta.

Después de hacer doble-click en la carpeta a importar pulse OK. En ese momento WinCvs examinara la
jerarquia para determinar cuantos ficheros se estan importando y determinar el tipo de cada uno de ellos
(text o binary). Este proceso se llama filtrado (filtering) y puede llevar algin tiempo si la jerarquia es
grande. Dirante este tiempo la ventana status de WinCvs visualizara una linea por cada carpeta examinada,
como se muestra a continuacion:

Filtering 'E:\New-Core'...

Filtering 'E:\New-Core\boot_strap'...
Filtering 'E:\New-Core\database'...
Filtering 'E:\New-Core\drivers'...

l.:j'lter‘j ng 'E:\New-Core\h'...
Filtering 'E:\New-Core\utilities'...
Filtering 'E:\New-Core\vme_trap'...
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Cuando se haya terminado el proceso de filtrado se visualizara el panel Import filter con los resultados del
mismo. Este panel lista las extensiones de ficheros encontradas en la jerarquia a importar y el tipo que cvs
le asignara al fichero (TEXT o BINARY). En el siguiente ejemplo hay 1 warning y no hay ningun error. El
warning indica que en un fichero con una extension que normalmente indica que el fichero es de texto
(TEXT) se han encontrado caracteres binarios. Los errores pueden ser ignorados (normalmente WinCvs
haré lo correcto) o se puede pulsar el boton Edit para cambiar lo detectado por WinCyvs.

Despues de que haya revisado el panel Import filter, pulse Continue para comenzar el proceso de
importacion:

Import filter

Fixthe errors (if any) before continuing the impart process

Entry state | Entry description | Entry kind |
toarning  File has some escape characters in it (0x0...

A Ok Type * WU TEXT
MoK Type*a BiMARY
A Ok Type*cm TEXT
MoK Type*ne TEXT
M 0K Type Makefile_sun TEXT
MoK Type *h TEXT
M 0K Type makefils TEXT
MoK Type * swp BINARY
A Ok Type Makefile TEXT
MoK Type*c TEXT

Edit | Carncel

Después de pulsar el boton Continue se visualizara el panel Import settings:

Import settings
Import settings llmpﬂﬁ-uptiunsl Glubalsl

— Selectthe module name and path on the remote server:

~ Initialwandor and release tags

Vendor tag | |Lam

Felease tag: Ilmpc:rt

— Enterthe log message ;

Import new version of Caore for AB

oK ;{I Cancel Al Help
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En este ejemplo estamos creando una nueva carpeta A6 bajo el modulo EtchPM ya existente. Notese que el
moddulo importado Data-A6 no aparecera en el repositorio. Todos los ficheros y subcarpetas de Data-A6
seran importados al repositorio en la carpeta A6. Este ejemplo muestra que una carpeta puede ser
importada con un nombre diferente. Hay que rellenar cuatro campos antes de iniciar el import:

- Introduzca el nombre del path y el médulo como se muestra arriba. Noétese que cvs
REQUIERE que se usen caracteres ““/” para separar los nombres de directorios. Si utiliza el
caraceter backslash (\) crearia un nuevo médulo llamado EtchPM\AG6 en la raiz del repositorio
en lugar de un nuevo directorio A6 bajo el directorio EtchPM existente.

- Entre cualquier cosa en los campos vendor tag y release tag. Estas etiquetas no se usan
normalmente y pueden ser borradas después. Utilice etiquetas como VTAG y RTAG y
borrelas después de que el import se haya completado. Desafortunadamente CVS las necesita
para el comando import. Pueden ser borradas después de que el import se haya realizado
seleccionando la carpeta del nivel superior y usando Delete tag en el ment Selections->Tag
selection.

- Introduzca un mensaje de log adecuado (este mensaje sera parte de la informacion de log
asociada a los ficheros para la version inicial 1.1) que aparecera en el fichero si la palabra
clave $Log se especifica en el mismo (solo ficheros de texto).

Después de que se hayan introducido todos los campos, pulse el boton OK para iniciar el import.

Durante la ejecucion del import, el comando de cvs que se ejecuta y la salida de este se visualizaran en la
ventana de status de WinCvs, como se muestra en este ejemplo:

cvs -q import -I ! -I cvS -wW "*.a -k 'b'" -w "*.swp -k 'b'" -m "Import new
version of Core for A6" NewCore Avendor Import (in directory E:\New-Core)
N NewCore/Auxiliary_Clock/auxClock.c

N NewCore/Auxiliary_Clock/Makefile

N NewCore/boot_strap/.readConfig.c.swp

N NewCore/boot_strap/makefile

NewCore/watchdog/Makefile

N
N NewCore/watchdog/watchdog.c

No conflicts created by this import

**CVS exited normally with code Q¥#*#***
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Ahora que los ficheros han sido importados al repositorio, se puede hacer checkout de los mismos al area
de trabajo ejecutando el comando update sobre el directorio padre. En este ejemplo, seleccione el
directorio EtchPM en la ventana del browser de WinCyvs y seleccione update con el botén derecho del
raton: Se visualizara el panel Update settings :

Update settings

Update setlings |‘St'|ck3_.r Dptiunai herge Dpﬁunsi Glubalsl

[ Checkoutfilesto standard autput (avoids stickiness)
[ Do notrecurse into sub-olders

" Resetany sticky date/tag/~k' optiohs

V¥ Create missing directories that existin the repositans

[-\O K. I Cancel Ay Help

"’%

Active la opcion Create missing directories that exist in the repository y pulse el boton OK para obtener
una working copy (copia de trabajo) de los ficheros importados en el area de trabajo.

En este ejemplo de comando import se ha creado un nuevo médulo. Sin embargo, el nuevo modulo no
aparecera en la lista de modulos disponibles hasta que su nombre sea afiadido a un fichero administrativo
llamado modules. Vea la Seccion 4.1 para saber como especificar nuevos modulos en el fichero modules.

3.11 Coordinacion entre varios programadores

El modelo que por defecto utiliza cvs para que puedan trabajar varios programadores se llama unreserved
checkouts. En este modo de funcionamiento varios programadores pueden editar a la vez su copia de
trabajo de un mismo fichero. Al primero de estos programadores que haga commit se le avisara de que
haga un update si otro programador ya ha hecho commit de sus cambios a un fichero mientras este fichero
estaba siendo modificado por aquel. El actualizar automaticamente el fichero con los cambios realizados
recientemente por otros programadores lo realiza cvs automaticamente sin que lo tenga que realizar el
programador a mano, y solo es necesario hacer la actualizacion manualmente cuando cvs encuentra
modificaciones que estan en conflicto y que no puede resolver el solo.

Cvs también soporta parcialmente el modelo reserved checkout. Parcialmente porque cvs no obliga a que

un fichero sea bloqueado antes de poder editarlo, pero no permitira hacer commit de un fichero que esta
bloqueado por otro programador. Los programadores pueden bloquear y desbloquear ficheros a voluntad.

3.11.1 Como funciona el update y el modelo Unreserved Checkout

Cuando los programadores usan el modelo unreserved checkout en cvs, cualquier niimero de
programadores puede estar trabajando en el mismo fichero a la vez. Como se explico en la Seccion 6.3,
hay que ejecutar el comando edit para marcar el fichero como modificable antes de que se puedan realizar
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cambios en el mismo. En cualquier momento se puede visualizar la lista de programadores que en ese
momento estan modificando un fichero seleccionando el fichero con el boton derecho del raton y
ejecutando la opcion Monitors selection->Editors of selection.

Cuando un programador intenta hacer commit de un fichero pueden suceder una de estas dos cosas:

- Sino hay ninguna version mas nueva del fichero en el repositorio, se creara una nueva version
de este fichero en el repositorio, como se explica en la Seccion 3.9. Esta es la situacion
normal cuando ningun otro programador esta trabajando en el mismo fichero, o bien si lo esta
pero se es el primero en hacer commit.

- Sien el repositorio ya existe una nueva version del fichero, cvs le mostrara un mensaje de
advertencia y abortara la operacion de commit.

En el caso de que cvs aborte la operacion de commit porque encuentre una nueva version del fichero en el
repositorio, WinCvs se lo advertira en la ventana de status con un mensaje similar al siguiente:

cvs -q commit -m "This is the change from user 1" gascal.c (in directory
E:\WorkAreaone\EtchPM\src)

cvs server: Up-to-date check failed for "gascal.c'

cvs [server aborted]: correct above errors first!

wxE%ECVS exited normally with code 1¥¥%¥*

En este caso, se debe usar primero el comando update para actualizar el fichero con los cambios realizados
por los otros programadores. Si el comando update se realiza con éxito, se visualizaran mensajes como los
siguientes:

cvs -g update gascal.c (in directory E:\WorkAreaOne\EtchPM\src)
RCS file: /Store/200mm/EtchPM/src/gascal.c,v

retrieving revision 1.2

retrieving revision 1.3

Merging differences between 1.2 and 1.3 into gascal.c

M gascal.c

#H%%ECVYS exited normally with code Q#%¥##**

En este caso, el status del fichero seguira siendo Mod. File pero la fecha de modificacion cambiara al texto
Result of Merge como se muestra a continuacion:

MName: | Rew. i Opti. I Status | Tag i Date I Canflict
alrm.c s File “Wwad har 31 00:38:36
anf_cmd.c 13 File Wed har 31 00:38:37 ...
anf_conr.c 1.4 File W'ed Mar 31 D0:55:45 .
ant_pid.c 1.2 Filz Tuebar3019:18:57 1.
applmain.c 1.2 File Tue Mar 30 19:18:52 1.,
chill_232.c 1.2 File Tue kMar301918:531..
cntrlpc 1.2 File % Tue bar30 19:18:56 1.,
confRing.c 1.2 File Tue Mar301918:57 1...
CounterTimer.c 1.2 File Tue bar 30 19:18:47 1.
endpaoint.c 1.2 File Tue Mar 30 19:18:58 1.,

Elgap lpc 1.2 File Tue bar 30 19:18:59 1.,
B gascale 1.3 tind.File Fasultof marge

E he. esc.c 1.2 File Tue Mar3019:19:02 1.

iodb_interface.c 1.3 File Wed Mar 31 02:48:32 .

ioDebug.c 13 File “Wied hMar 31 02:48:32 .

® 1=l iolitilities.c 1.2 File Tue Mar30 19:19:065 1.
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Después de esto, ya se puede ejecutar otra vez comando commit para que el fichero actualizado con los
cambios realizados por otros programadores sea copiado en el repositorio.

En el caso de que el comando update falle porque cvs no sea capaz de actualizar el fichero con los cambios
que estan en la version del fichero en el repositorio, pero no estan en la copia de trabajo del fichero, se
visualizaran mensajes similares a los siguientes:

cvs -q update gascal.c (in directory E:\WorkAreaoOne\EtchPM\src)
RCS file: /Store/200mm/EtchPM/src/gascal.c,v

retrieving revision 1.4

retrieving revision 1.5

Merging differences between 1.4 and 1.5 into gascal.c

rcsmerge: warning: conflicts during merge

cvs server: conflicts found in gascal.c

C gascal.c

wwxwkCcysS exited normally with code Q¥*¥*%*

Observe la “C” indicando que se encontraron conflictos. En este caso el status del fichero cambiara a
Conflict y la fecha cambiara a Result of Merge como se muestra a continuacion:

MName: | Rew. i Opti. I Status | Tag Date Canflict
Sl alm.c s File “Wwad har 31 00:38:36
anf_cmd.c 13 File Wed har 31 00:38:37 ...
anf_conr.c 1.4 File W'ed Mar 31 D0:55:45 .
ant_pid.c 1.2 Filz Tuebar3019:18:57 1.
applmain.c 1.2 File Tue Mar 30 19:18:52 1.,
chill_232.c 1.2 File Tue kMar301918:531..
cntrlpc 1.2 File Tue bar30 19:18:56 1.,
confRing.c 1.2 File Tue Mar301918:57 1...
CounterTimer.c 1.2 File Tue bar 30 19:18:47 1.
endpaoint.c 1.2 File Tue Mar 30 19:18:58 1.,
gap_ lpc 1.2 File Tue Mar 30 19:18:59 1.

] 1.5 Conflict ult of merge

B BECC k 1.2 File Tue Mar3019:19:02 1.,
iodb_interface.c 1.3 File Wi'ed Mar 31 02:48:32 ..
inDebug.c 1.3 File YWed har 31 02:458:32 .
WISl iolUtilities.c 1.2 File Tue bMar 30 19:19:061...

En este caso, el fichero resultante debe ser re-editado para resolver los conflictos manualmente. Los
conflictos se pueden localizar buscando en el fichero las cadenas de caracteres <<<<<<<, ========y
>>>>>>> como se muestra en el siguiente ejemplo:

/**************************************************************
*

* new_function_from_user_1

*

*/

<<<<<<< gascal.c

void new_function_1(d, e, f)

void new_function_1(a, b, ¢c)
>>>>>>> 1.5

{
}
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El programador debe suprimir manualmente las lineas con <<<<<<< =======y >>>>>>>y resolver
los conflictos para las indicadas. Despues de que los conflictos hayan sido resueltos se debe volver a
ejecutar el comando commit.

Si el programador intenta hacer commir sin resolver ninguno de los conflictos, cvs visualizara el siguiente
mensaje de error y abortara la operacion de commit:

cvs -q commit -m "This is the change from user 1\n\n" gascal.c (in
directory E:\WorkAreaone\EtchPM\src)

cvs server: file "gascal.c' had a conflict and has not been modified
cvs [server aborted]: correct above errors first!

*CVS exited normally with code 1%**

Si el programador resuelve solo algunos de los conflictos pero deja el fichero con otros conflictos sin
resolver, cvs visualizara el siguiente mensaje de error cuando se haga el commit:

cvs -q commit -m "This is the change from user 1\n\n" gascal.c (in
directory E:\WorkAreaone\EtchPM\src)

cvs server: warning: file "gascal.c' seems to still contain conflict
indicators

Checking in gascal.c;

/Store/200mm/EtchPM/src/gascal.c,v <-- gascal.c

gew revision: 1.6; previous revision: 1.5

one

Teddhn

CvsS exited normally with code Q¥%**%*%*

Notese que a pesar de esto cvs hard commit del fichero aunque detecte alguno de los indicadores de
conflicto (<<<<<<K, ======= 0 >>>>>>>). Probablemente esto no sea una caracteristica deseable en
cvs, pero es asi como funciona. Si accidentalmente se hace commit de un fichero que todavia contiene
indicadores de conflictos, el fichero debe ser editado, vuelto a modificar y se debe hacer commit otra vez
para suprimir los indicadores de conflicto y resolver los conflictos que queden aun.
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3.11.2 Como funciona el sistema de bloqueos y el modelo Reserved Checkout

Como se dijo en la Seccion 3.11, cvs soporta el modelo reserved checkout . El comando lock es la base de
este modelo. Bloqueando un fichero en cvs se evita que otro programador tambien pueda bloquearlo ni
hacer commit de una nueva version del fichero. Esta forma de trabajar es segura en tanto que evita que otro
programador pueda hacer commit afiadiendo una nueva version del fichero al repositorio, pero sigue
permitiendo que otro programador edite el fichero (su copia en el area de trabajo). Esto puede producir
frustracion, si un programador olvida bloquear el fichero pero si lo edita. Cuando el programador intente
hacer commit del fichero, la operacion fallara como se muestra en el siguiente ejemplo:

cvs -q commit -m "This is the change from user 2\n\n" gascal.c (in
directory E:\WorkAreaTwo\EtchPM\src)
cvs [server aborted]: Revision 1.7 1is already locked by apples

JORORORONT)
LR

‘CVS exited normally with code L1#¥#*%**

Si todos los programadores cooperan y se ponen de acuerdo en bloquear un fichero antes de editarlo, esta
situacion no se dard. Como alternativa a esto se puede usar el modelo unreserved checkout .

Como sucede con otros comandos, WinCvs tiene varias maneras de invocar el comando lock :
1) Seleccione el fichero(s) usando el boton izquierdo del ratén y el ment Selections:

Selections->Monitors selection->Lock selection

2) Seleccione un fichero usando el boton derecho del raton y la opcion Monitors selection-
>Lock selection

3) Seleccione el fichero(s) usando el boton izquierdo del ratdon y el icono correspondiente de la
barra de herramientas:

Utilize el comando unlock de una de estas formas para desbloquear el fichero:

1) Seleccione el fichero(s) usando el boton izquierdo del raton y use el menu Selections:

Selections->Monitors selection->Unlock selection

2) Seleccione un fichero usando el boton derecho del ratén y escoja la opcién Monitors
selection->Unlock selection

3) Seleccione el fichero(s) usando el boton izquierdo del raton y utilice el icono correspondiente
de la barra de herramientas:

‘ hlﬂ %75 J"I@l_ﬂ

Si la operacion de lock tiene éxito, se visualizaran los siguientes mensajes en la vantana status:

cvs -gq admin -1 gap_Tp.c (in directory E:\WorkAreaTwo\EtchPM\src)
RCS file: /Store/200mm/EtchPM/src/gap_lp.c,v

1.2 locked

done

“*CVS exited normally with code Q¥#*#***
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Si la operacion de lock falla, se visualizara informacion indicando quien tiene bloqueado actualmente el
fichero:

cvs -gq admin -1 gascal.c (in directory E:\WorkAreaTwo\EtchPM\src)
RCS file: /Sstore/200mm/EtchPM/src/gascal.c,v
cvs [server aborted]: Revision 1.7 1is already locked by apples

wH%k%ECVYS exited normally with code 1#¥¥#**

Desde todos los menus y tambien desde la barra de herramientas se puede ejecutar el comando Log para
conocer el estado de un fichero en cuanto al bloqueo. La salida del comando se visualiza en la ventana de
status como se muestra en este ejemplo donde el usuario don tiene bloqueada la version 1.2 del fichero

gap lIp.c:

Rcs file : '/Store/200mm/EtchPM/src/gap_lp.c,v'
working file : 'gap_lp.c'
Head revision : 1.2
Branch revision
Locks : strict
1.2 : 'don'

Hay algunos casos en los que se puede tener bloqueadas multiples versiones de un fichero. Si se intenta
usar el comando unlock en este caso, se obtendra el siguiente mensaje de error:

cvs -q admin -u gap_Tp.c (in directory E:\WorkAreaTwo\EtchPM\src)

RCS file: /Store/200mm/EtchPM/src/gap_lp.c,v

cvs server: /Store/200mm/EtchPM/src/gap_Tp.c,v: multiple revisions locked
by don; please specify one

cvs server: cannot modify RCS file for "gap_lp.c'

JORORORONT)
wRARD

“CVS exited normally with code 1%%*%*%**

En este caso, debe desbloquear una determinada version del fichero usando el comando cvs admin,
tecleandolo en la ventana de status de WinCvs. En este ejemplo, la version 1.1 de gap_lp.c ha sido
desbloqueada (el programador ha tecleado aqui el comando cvs —q admin —11.1 gap _Ip.c):

cvs -q admin -11.1 gap_1p.c

Tededhn

CvsS exited normally with code Q#%**%*%*

SCS file: /Store/200mm/EtchPM/src/gap_lp.c,v
one
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Seccion 4 —- Comandos Administrativos

Esta seccidn trata sobre comandos que normalmente deberian ser usados solo por un administrador de cvs.
Para editar cualquier fichero administrativo, hay que hacer checkout del médulo CVSROOT en un area de
trabajo local. Vea las seccion 3.4 para informacion sobre el comando checkout. A continuacion se muestra
un area de trabajo con una version de CVSROOT obtenida mediante checkout:

e - [E:AMautilusTestiCYSROOTY]
File  Edit Wiew OCvsAdmin CusFiles CwsFolders Selecions Window Help

= A 0 T T M S B NS | Blaale) 25z =] 5| sl )] 2] B
mlaf &
=3 NautilusTest hame | Rew. | Opti... |:5tatus | Tag | Diate |"inbnﬂ'|ct |
21 Care R 2] checkoutlist 11 File Thu Meay 13 18:55:35
B ] commitino 11 File Thu May 13 19:55:35 ..
R E) corfig 11 File Thu Mayy 13 19:86:35 ..
&2 TestEmpty R/ cvsumrappers 11 File Thu May 13 19:55:35 ..
11 File: Thu May 13 19:55:34
1.1 File ThuMay 13 19:55:34 .
1 File Wad bay 19 00:06:37 ...
= 11 File Thu May 13 19:55:35 ..
‘&[‘;] resinfo 1.1 File Thu hay 13 13:56:34 ..
w5 taginfa 11 File Thu ey 13 19:55:35 ..
RE verifymsg 11 File Thu May 13 19,85:35 ...

CVSROOT: :pserver:don@nautilus:/usrflocal/cvs-test (pagsword authentication)
TCL is available, shell is enabled : help (select and press enter)

FarHelp, press Fl I i VA

Observe que hay 11 ficheros administrativos en el médulo CVSROOT. Estos ficheros permiten manejar
muchas caracteristicas avanzadas de cvs. Vea el apéndice C (pag 125) del manual de referencia de cvs para
una descripcion completa de estos ficheros y sus caracteristicas, incluido el fichero opcional passwd.

En esta seccion describiremos solamente el uso del fichero modules .

4.1 Editar el fichero administrativo modules

El fichero modules de cvs lista las jerarquias de carpetas para las que se puede hacer checkout desde el
repositorio usando el comando Cvs Admin->Checkout module... del menu principal de WinCvs. Usando
el fichero modules a cualquier parte de la jerarquia de un mddulo o a varios mddulos existentes se les puede
asignar un solo nombre.

Si se importa un moédulo a cvs y no se pone en el fichero modules, se podra hacer checkout del mismo, pero
no sera listado en la salida del comando Cvs Admin->Macros admin->List the modules on the server del
menu principal de WinCyvs.

Para poder editar el fichero modules, se debe hacer primero checkout del médulo CVSROOT, como se
menciond en la introduccion a la Seccion 4. Ademas, el fichero debe ser marcado como modificable, como
se dijo en la Seccioén 3.6.
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A continuacion se muestra un ejemplo de fichero modules:

Three different 1ine formats are valid:
key -a aliases...
key [options] directory
key [options] directory files...

where "options" are composed of:

-i prog Run "prog" on "cvs commit" from top-level of module.

-0 prog Run "prog" on "cvs checkout" of module.

-e prog Run "prog" on "cvs export" of module.

-t prog Run "prog" on "cvs rtag" of module.

-u prog Run "prog" on "cvs update" of module.

-d dir Place module in directory "dir" instead of module name.
-1 Top-level directory only -- do not recurse.

NOTE: If you change any of the "Run" options above, you'll have to
release and re-checkout any working directories of these modules.

And "directory" is a path to a directory relative to $CVSROOT.

The "-a" option specifies an alias. An alias is interpreted as if_
everything on the right of the "-a" had been typed on the command Tline.

You can encode a module within a module by using the special '&'
character to interpose another module into the current module. This
can be useful for creating a module that consists of many directories
spread out over the entire source repository.

HHHEH R

EtchPM EtchPMm
Core Core
EtchPM-Source EtchPM/src

La Seccion C.1 (pag 125) del manual de referencia de cvs describe el fichero modules en detalle. Como
todos los ficheros después de modificados, hay que hacer commit del fichero modules al repositorio
(Section 3.9) antes de que los cambios tengan efecto.

4.2 Acciones a realizar cuando el repositorio queda bloqueado

Internamente cvs realiza un bloqueo sobre el repositorio para evitar accesos simultaneos de varios usuarios
. El bloqueo es realmente un directorio de del repositorio llamado #cvs . Tock. Siuna operacion de cvs
aborta, es posible que este bloqueo sobre el repositorio permanezca, impidiendo que despues de esto se
puedan realizar otras operaciones. En este caso el mensaje “waiting for user’s lock” se visualizara en la
ventana de status, como se muestra en el siguiente ejemplo donde el usuario R2D2 es el que tiene el
bloqueo (el que tiene bloqueado el repositorio):

cvs admin -bLockTest2 -u applmain.c
wHk%ECVS exited normally with code Q¥ ¥¥**

cvs server: [13:46:22] waiting for R2D2's lock in /Store/200mm/EtchPM/src

Normalmente este mensaje significa que el usuario R2D2 esta en el proceso de actualizar el repositorio.
Esto normalmente no deberia ocupar mucho tiempo, al cabo del cual el bloqueo se quitaria como se
muestra a continuacion:
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cvs server: [13:46:52] waiting for R2D2's Tock in /Store/200mm/EtchPM/src
cvs server: [13:47:22] obtained lock in /Store/200mm/EtchPM/src

RCS file: /Store/200mm/EtchPM/src/applmain.c,v

é.2.6.2 unlocked

one

En los casos en que cvs aborte por alguna razén (p.e. pérdida de la comunicacion de red o rearranque de la
maquina), puede ser necesario quitar el bloqueo manualmente. El directorio #cvs.Tock localizado en el
repositorio en cuestion y borrado usando el comando rmdir de UNIX (supuesto que el repositorio esta en
una maquina UNIX).

4.3 Gestion de versiones

El mecanismo basico para mantener varias versiones de un producto usando cvs es la etiqueta. Las
etiquetas se describen en la Seccion 4.4 (pag 32) del manual Version Management with CVS. Cuando un
producto ha sido testeado y esta preparada una version de produccion del mismo con un determinado
conjunto de versiones de ficheros, entonces los ficheros pueden ser etiquetados con un nombre simbolico.
Los ficheros pueden ser modificados después de la version de produccion, pero la version etiquetada se
puede recuperar siempre.

El problema que siempre se plantea con el manejo de versiones es que hacer cuando se detecta un bug
despues de que se ha sacado una version de produccion del producto. Probablemente los ficheros del
repositorio han sido modificados despues de lanzarse la version de produccion y no son lo bastante estables
como para generar una nueva version de produccion que corrija el bug.

La solucidn a este problema es crear una bifurcacion (branch) a partir de la version que hay en el
repositorio etiquetada cuando se generd la version de produccion (que no es la Gltima). Después de esto,
los ficheros de la bifurcacion pueden ser modificados sin interferir con el hecho de que contintie el
desarrollo para la bifurcacion principal (técnicamente la bifurcacion principal se llama trunk). Después de
que se haya comprobado la solucion de los errores, la etiqueta de la version de produccion original puede
ser trasladada a las nuevas versiones de los ficheros, o se puede crear una nueva etiqueta de version de
produccion.

Las dos secciones siguientes muestran ejemplos de como mover una etiqueta a una nueva version de
produccion y como crear una nueva etiqueta para una version de produccion.
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4.3.1 Etiquetar una versién de produccion

Cuando un conjunto de ficheros han sido testeados y estan listos para generar una version de produccion, se
deben etiquetar para marcar su estado actual. En el siguiente ejemplo se visualiza un area de trabajo para el
producto EtchPM2. Se muestra parcialmente el listado de ficheros de la carpeta src para mostrar el
conjunto de numeros de versiones (1.1, 1.2, and 1.4).

& - [E:\CVE-Work-AreasStore-200mmiEtchPM2\srck]
File Edit ¥iew CusAdmin CwsFiles CvsFolders Selections Window Help

H|Ex] |

=T 1 N - T Y
ml=) &

= Blaie| 2(E(m] =2 ]| =] w5l 2l |

=3 Store-200mm Name | Bew | Opti... |:Status | Tag | Diate |LG'0anict | &
-3 CYSROOT WE almc 12 File Thu Jun 03 22:10:25 1
21 EtchPM RIE ant cmde 1.2 File Thu Jun 03 2210:26 1.,

EtchPhe =] anf_com.c 1.2 File Thu Jun 03 22:10:26 1.
=0 dats WE| ant_pidc pa File Thu Jun 03 22:10:26 1
#4.1 doc W =] applmain.c Jid File Thu Jun 03 22:51:57 1.
-1 EtchPh WIS chill_232c 142 File Tue Jun D8 23:33:25 1.

Fh W] entrlp.c 14 File Tue Jun 08 23:31:491..,
L1 Fh_sim RI=] confRing.c 1.2 File Tue Jun 08233325 1...
& w Rl%] CountetTimear.c T File Tue Jun 08 23:33:25 1.,
l}\ ®E endpoint.c 11 File Tue Jun 08 23:33:251..,
RE gap_lpc 11 File: Thu Jun 03 21:54:521
W2 gascalc 11 File Thu Jun 03 21:54:62 1.
=] he_escc 1.1 File Thu Jun 03 21:54:52 1.,
W] indb_intedace o 11 File ThuJun 03 21:54:62 1
W |5 ioDebug.c 1.1 File Thu Jun 03 21:54621..
W =] inLtilities.c 11 File Thu Jun 03 21:54:621.., ;]

.CVSRDOT: i pserver:don@snow: [Store/200mm (password authentication)
TCL is available, shell is enabled : help (select and press enter)

v

ForHelp, press F1

Suponiendo que el area de trabajo EtchPM2 representa un conjunto de ficheros testeados, estos pueden ser
etiquetados para generar una version de produccion con el comando tag.
El comando tag se puede invocar de cualquiera de estas formas:

1) Seleccione la carpeta de mayor nivel en la jerarquia (EtchPM2 en este caso) con el boton
izquierdo del raton y ejecute la opcion de menu Selections->Tag selection->Create a tag. ..

2) Seleccione la carpeta con el boton derecho del raton y seleccione la opcion Tag selection-
>Create a tag... del menu emergente.

3) Seleccione la carpeta usando el boton izquierdo del raton y después el icono de la barra de
herramientas:
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Despues de invocar el comando tag se visualizara el panel Create tag settings, como se muestra a
continuacion:

Create tag setlings

Create tag seflings I Globals |

Enterthe tag name to cresle
[Ngwt&gnamé: IReIease—1 _"_l

[T Dwerwrite existing tags with the same namea

[T Do nat recurse into sub-directories

W Check that the files are urmoditied befors tanging

=)

£ r:\g | Cancel Help

El panel Create tag settings tiene un campo para introducir el nombre de la etiqueta y tres opciones. El
nombre de la etiqueta no debe contener ninguno de los siguientes caracteres: $ , . : ; @.

La opcion Overwrite existing tags with the same name especifica que cualesquiera etiquetas con el mismo
nombre que se encuentren sean trasladas a la version actual (la que hay en el area de trabajo actual).

La opcion Do not recurse into sub-directories puede ser util cuando solo se desea etiquetar una carpeta.

Es una buena practica marcar la opcion Check that the files are unmodified before tagging, pues no tiene
mucho sentido tener ficheros en el area de trabajo que hayan sido modificados pero para los cuales no se
haya hecho commit.

Despues de introducir la etiqueta y haber seleccionado las opciones deseadas, pulse OK para comenzar el
proceso de etiquetado. Durante la operacion cvs visualizara los ficheros mientras van siendo etiquetados,
como se muestra a continuacion:

cvs -q tag -c Release-1 (in directory E:\CvS-work-Areas\Store-
200mm\EtchpPm2\)
T Makefile

#%%%CVS exited normally with code Q#**¥*=*
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4.3.2 Corregir errores después de generar una version de producciéon

Cuando se detecta un error en una version de produccion (probablemente instalada y funcionando en
cliente(s)), el procedimiento usual es generar una version incremental con los minimos cambios necesarios
para corregir el error. El primer paso para esto es crear el area de trabajo en la que se va modificar la
version de produccion para generar la version incremental. Dependiendo del producto, puede necesitarse
un solo fichero o todo el arbol del repositorio. El area de trabajo se creara de forma que contenga la
version de todos los ficheros que se etiquetaron con un determinado identificador o etiqueta en el momento
de generar la version de produccion, es decir, en el estado en que estaban en ese momento (desde entonces
el desarrollo probablemente ha continuado, por ejemplo incorporando nuevas funcionalidades al producto).

4.3.2.1 Crear el area de trabajo

Si ya existe un area de trabajo para el producto o médulo, esta puede ser actualizada a la version que se
quiere modificar con el comando update (Seccion 3.5). Sin embargo, esta forma de proceder puede
producir resultados no deseados: piensese por ejemplo que sucede si en el area de trabajo ya hay ficheros
que han sido modificados pero para los cuales no se ha hecho commit o si la estructura de carpetas ha
cambiado desde que se etiqueto la version que ahora hay que modificar.

El mejor método para crear un area de trabajo a partir de una version etiquetada es usar el comando
checkout (Seccion 3.4) y hacer un checkout de la version etiquetada que se quiere modificar a una nueva
area de trabajo. Cuando se invoque el comando checkout se visualizara el siguiente panel:

Select a directory to checkout to : EE3

Select a directony to checkoutto

el ovewark-araaspatch-200 k
Cancel
= ey -] —I
= OV Waork-Areas

Fatch-200

Drives:

e: Don j Metwark. . |

Seleccione la carpeta donde se creara el area de trabajo. Recuerde que debe hacer doble-click en la carpeta
y ver el icono de carpeta abierta como se muestra arriba.
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Una vez seleccionada la carpeta deseada, haga click en OK para continuar con el proceso de checkout. Se
mostrara el panel Checkout settings .

El panel Checkout settings se muestra a continuacion. Introduzca el nombre del médulo y vaya al panel
Checkout options haciendo click en la solapa como se muestra a continuacion:

Checkout settings

Checkout setings | Checkout options | Glubalsi

—Enterthe module narme and path onthe seryer:

EtchPhd2 j

i~ Local place to checkoutto:
‘ Change folder - | EACVSSWork-Areas) Patch-200

" Checkoutfiles ta the console window (avoids stickiness]

[T Donotrecurse

=)

ok | cencel Help

El panel Checkout options se muestra a continuaciéon. Marque la opcioén By revision/tag/branch e
introduzca el nombre de la etiqueta correspondiente a la version de produccion que desee obtener:

Checkout settings

Checkout settings  Checkout options | Globals i

— Checkout (sticky) options:
I Bydate: | =

I By revisionftagbranch ;

[ It no matching revision is found, use the most recent one

(0] & I Cancel Ay Help

Despues de introducir el nombre de la etiqueta haga click en OK para inciar la operacion de checkout.
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Durante la operacion de checkout, cvs mostrara cada fichero como a continuacion:

cvs -q checkout -r Release-1 EtchPM2 (in directory E:\CVS-work-
Areas\Patch-200)

U EtchpPm2/Makefile

U EtchPM2/EtchPM/Makefile

U EtchPM2/h/gascal.h

*REEECVS exited normally with code Q%#*¥#**

Despues de que se haya realizado el checkout utilice el comando View->Change browser location del ment
principal o la barra de herramientas para apuntar al area de trabajo que acaba de crear. A continuacion se
muestra un ejemplo de area de trabajo creada para la version etiquetada como Release-1 :

;;-' - [E:\CV5-Work-Areas\Patch-200\EtchPM2\srcl]
File Edit “iew CvsAdmin CvsFiles CwsFolders Selections Window Help

IR BSOS EE D ENEEEE e T T e ) ST K5 s S WA P
i |
E Patch-200 Name | Rewv. | Ciptic |:Siatus | Tag | Diate |1J;£..”t|nﬂ'|ct | a
= EtchPh2 R[E alrm.c 1.2 File Release-1 Thu Jun 03 22:10:251...
] data R[5 anf_cmd.c 12 File Felease-1 Thu Jun 03 22:10:26 1
#+ doc R/E ant_com.c 12 File Release-1 Thu Jun 03 22:70:261...
i L1 EtchPid 12 File Felease-1 Thu Jun 03 22:10:26 1.
LETh i File Fielease-1 Thu Jun 03 22:11:00 1
BrE3 Fhd_sim 1.2 File Release-1 ThuJun 03 22:17:26 1.
i | E 14 File Felease-1 Thu Jun 03 23:24:141...
% |E] confRing.c 12 File Felease-1 Thu Jun 03 22:17:26 1
‘R@ CounterTimer.c 12 File Release-1 Thu Jun 03 221726 1.,
R[5 endpaint.c 11 File Fielease-1 Thu Jun 03 215452 1..,
RE gap_lpe 11 File Felease-1 Thu Jun 03 21:54:52 1
gascal.c 157 File Release-1 Thut Jun 03 21:54:52 1.
he_escc 1.1 File Felease-1 Thu Jun 03 21:5452 1.
indb_intetface o 1.1 File Release-1 Thu Jun 03 21:5452 1
ioDebug.c 1.1 File Felease-1 Thu Jun 03 21:54:52 1..,
R IE] ioltilities.c 1.1 File Felease-1 Thu Jun 03 21:54.621...

Ll

EtchPM2/src/sily pump.c
EtchPM2/src/sily rcp.c
EtchPM2/srcfsily temp.c
EtchPM2/src/tasks.c

EtchPM2/src/tempetrl.c
EtchPM2/src/wat cntrl.c

c e e c

*ekr*CMS exited normally with code Q*****

ForHelp, press Fi [

Ahora que se ha creado un area de trabajo con los ficheros a las versiones en que estaban cuando se
etiquet6 la version del producto para produccion, debe crear una bifurcacion para realizar las
modificaciones necesarias para corregir el error(es). La seccion siguiente explica la forma de crear una
bifurcacion a partir de la version que se acaba de poner en el area de trabajo.

47



4.3.2.2 Crear una bifurcacion

Los ficheros del area de trabajo que contiene la version de produccion etiquetada no se pueden etiquetar y
hacer con ellos commit. Para hacer modificacionea a estos ficheros se necesita crear una bifurcacion. Siya
existe una bifurcacion utilice el comando update (Seccion 3.5) para poner en el area de trabajo la tltima
version de la bifurcacion. Si no existe una bifurcacion para la version etiquetada que quiere modificar, cree
una como se muestra en esta seccion.

Como sucede con otros comandos, WinCvs tiene varias formas de invocar el comando branch (fork):

1) Seleccione el(los) fichero(s) o carpeta(s) usando el boton izquierdo del raton y la siguiente
opcion de ment: Selections->Tag selection->Create a branch...

2) Seleccione el(los) fichero(s) o carpeta(s) usando el boton izquierdo del raton y después el
boton derecho para abrir el ment Selections. Aqui seleccione la entrada

Tag selection->Create a branch...

3) Seleccione el(los) fichero(s) o carpeta(s) usando el botdn izquierdo del ratéon y después el
icono de la barra de tareas:

Cuando se invoca el comando branch (fork), el panel Create branch settings se visualizara como se muestra
a continuacion:

Create branch settings

Crasate branch settings | Globals |

Enterthe branch name to creste
[New branch name : IReIease—1—DeveImeent _-r_l

[~ Do not recurse into sub-directories

¥ Check thatthe filas are unmodified befure.br&ihthi'ﬂ'g?

=)

Ok & | Cancel il Help

Introduzca el nombre que desee dar a la bifurcacion y pulse el boton OK. Es buena practica dar a la
bifurcacién un nombre que identifique claramente el proposito del mismo. Como en este caso vamos a
desarrollar sobre la version etiquetada como Release-1 un nombre epropiado puede ser Release-1-
Development.

El panel Create branch settings tiene dos opciones que pueden ser utiles en ciertos casos. Es una buena
practica marcar la opcion Check that the files are unmodified before branching (comprobar que los ficheros
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no han sido modificados antes de crear la bifurcacion), ya que no tiene mucho sentido crear una bifurcacion
a partir de ficheros que han sido modificados pero para los que no se ha hecho commit. También es util a
veces marcar la opcion Do not recurse into sub-directories, ya que a veces se crea una bifurcacion para una
sola carpeta y no se necesita que en la bifurcacion estén las subcarpetas de esta (que es la opcion por
defecto).

La ventana de status mostrara como progresa la creacion de la bifurcacidon, como se ve a continuacion:

cvs -q tag -b -c Release-1-Development (in directory E:\CVS-wWork-
Areas\Patch-200\EtchPM2\src\)

T CounterTimer.c

T Makefile

T PM_WaferFlow.c

***%CVS exited normally with code 0**

La bifurcacion se creara a partir de la version de los ficheros que se crearon en el area de trabajo al hacer
checkout. Notese que WinCvs usa el comando tag con la opcién —b para crear la bifurcacion. También se
puede introducir manualmente este comando en la ventana de status de WinCvs.

Notese también que no por el hecho de crear una bifurcacion se actualiza el area de trabajo a la version de
la bifurcacion (la operacion de crear la bifurcacion se hace contra el repositorio solo). Es necesario usar el
comando update (Seccidn 3.5) para actualizar el area de trabajo a la bifurcacion que se acaba de crear.

Una vez que la bifurcacion ha sido creada y el area de trabajo actualizada, los ficheros pueden ser
modificados y se puede hacer commit de estas modificaciones (contra la bifurcacion en el repositorio, la
linea principal de desarrollo continua por su camino) como se describi6 en las secciones 3.6 a 3.9. Una vez
que se hayan realizado y probado todas las modificaciones, hay dos posibilidades para etiquetar una nueva
version de produccion, que se describen en la siguiente seccion.
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4.3.2.3 Etiquetar la nueva versién de produccion

En el ejemplo anterior se hizo checkout de una version de produccion etiquetada como Release-1, y se
modificaron algunos ficheros creandose una bifurcacion llamada Release-1-Development. En este punto,
la persona responsable de versiones tiene dos opciones: los ficheros modificados pueden ser reetiquetados
con la etiqueta originar Release-1 o generar una nueva version de produccion con una nueva etiqueta. En
los casos en que Release-1 ha sido suministrada a muchos clientes, la version de produccion original
etiquetada como Release-1 no deberia se modificada, necesitandose una nueva version de produccion con
una nueva etiqueta. Sino se ha llegado a suministrar ninguna copia de Release-1, puede ser una buena
opcion reetiquetar los ficheros modificados con la etiqueta original Release-1. A esto Gltimo se le llama
trasladar las etiquetas, pues estas son realmente trasladadas de una version a otra solo para los ficheros
modificados.

En cualquier caso, el comando tag hay que invocarlo como se describi6 en la Seccion 4.3.1. El siguiente
panel muestra que opciones hay que marcar para crear una nueva version etiquetada llamada Release-1-
Patch:

Create tag setlings

Createtag seftings I Globals I

Enterthe tag name to cresle
[Newiagname : IReIease—1 -Fatch :_J

[ Dverwrite existing tags with the same name;

¥ Do not recurse into sub-directories

¥ Check that the files are unmodified before tagging

0] [: | Cancel | Ay I Help |

Estas opciones se usarian para reetiquetar la nueva version con la etiqueta original Release-1:

Create tag setlings

Createtag seftings I Globals I

Enterthe tag name to cresle
[Newiagnamé: IReIease—1 :_J

V¥ Dwerwrite existing tags with the same namea

¥ Do not recurse into sub-directories

¥ ECheckthatthe files are unmodified before tagging

0] f | Cancel Ay Help
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